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IN MEMORIAM:

PRESIDENT'S
MESSAGE
I never thought that I would be writing another message of this type so
soon after the passing of Susana
Greiss; however, The New York
Circle of Translators has suffered
another loss. My predecessor, Slavica
Zecevic-Pralica passed away in early
June, after battling cancer for months.
I first remember meeting Slavica
when she was our program director.
She was bubbly and affectionate and
genuinely happy to meet and greet
each member at our functions. She
brought us many lively and interesting programs during her tenure, both
social and educational. Slavica then
undertook Presidential responsibilities
during a very difficult year for the
Circle, one that saw several officer
resignations. She was already very ill
at that point, and despite her illness,
she continued to provide Circle
Members with the best services and
programs she could muster. Her
determination kept the Circle alive
and functioning during a difficult
period and I, as a member, am very
grateful for her dedication to us.
When I remember Slavica, I will
think of my first impression of
her—a joyful, lively person, active at
Circle functions, constantly aware of
what had to be done in order that the
Circle prosper. I think this is the
image she would have preferred.
Slavica, rest in peace.

May/June 2006

SLAVICA ZECEVIC-PRALICA
1950-2006
by Matt Keenan, her partner

I

t is with great sorrow that the Gotham

known to have said that books were her

reports the passing of one of our

best friends. Not only did she study and

members and our former President and

appreciate the great writers and classics,

Program Director, Slavica Zecevic-Pralica.

she was also an avid follower of the great

Slavica was a special person whose dedica-

painters, composers, operas and ballet. A

tion, courage and perseverance gave

quick peek into her apartment would reveal

inspiration to all of us. While it is so diffi-

her affinity for Shakespeare, Bach, Chopin,

cult to talk briefly about the goodness of a

Verdi, Placido Domingo, Pavarotti,

wonderful member and person, I certainly

Picasso, Santiago, Dalí, and her favorite

hope that that this writing will be as honor-

Leonardo DaVinci. In fact, as difficult as it

able and as worthy as was our fine

was for her, Slavica attended an opera at

associate. Where does one begin when try-

Lincoln Center in January and a Broadway
(continued on next page)

ing to describe a person's life and their
accomplishments and simultaneously to
show who that person was and how they fit

INSIDE

into the whole scheme of our lives? Well, I
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guess we just have to go back to the begin-
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The ATA and the

ning and work our way up to the present.
Slavica was born in Belgrade Yugoslavia
on July 5, 1950. Spending her young adult

Mohammed Yousry Case
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Translating Arabic Into
Injustice
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Lost in Translation
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Translation Tools Seminar
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Trados Overview

in 1991 became a certified Translator in
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NYCT May Meeting

Yugoslavia. Slavica loved books and is
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Circle News

life in Yugoslavia, she attended the
University of Belgrade and received her
Bachelors degree in Literature in 1985 and
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year old son, Andre, if they left

Between the years of 1985 to 1994,

Yugoslavia. At first she had a strong

Slavica worked as a Serbian/Croatian/

desire to go to Canada, but eventually

Bosnian translator, interpreter and lan-

opted to come to the United States

guage consultant. She was very much

where her mother resided in Clifton,

involved with translating and subtitling

New Jersey. At first Slavica found it dif-

films along with television-series pro-

ficult. She came here with no contacts,

grams for Belgrade Television. For five

no job, and no friends and was a single

years Slavica worked as a group leader

Mom. Would there be a need for a

and interpreter for a European children's

Serbian translator in New Jersey?

fair called "Joy to the World" which was

Additionally, she was always concerned

sponsored by UNICEF. Additionally,

about her son's welfare and his adjust-

she enjoyed being an editor and proof-

ment to a new way of life. Several years

reader for a Yugoslavian Publishing

ago she moved to Hoboken in order to

House.

be closer to New York.

However, things began to change in

Slavica decided that it would be best to

Yugoslavia. There was political turmoil

work as a freelance interpreter and

and upheaval. So, Slavica decided that

translator as opposed to using her skills

life might be better for her and her 14

for some company on a 9 to 5 basis.
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Consequently, Slavica

fine people in these organi-

opened up many different

I AM NOT RESIGNED

zations, and in 2004 she

doors by doing such a wide

Dear Slavica,

became a Board member of

variety of things that even-

This poem by Edna St. Vincent Millay conveys my thoughts. I will always
remember you, I will continue to miss you, and I am not resigned. R.

the Circle serving as the

tually she was busy
running around the metropolitan area to interpret
depositions for attorneys or
going to medical facilities
to assist patients with communication with their
medical providers. In
between, Slavica would
also be translating a whole
assortment of documents
covering the medical, legal
and business community.

I am not resigned to the shutting away of loving hearts in the hard ground.
So it is, and so it will be, for so it has been, time out of mind:
Into the darkness they go, the wise and the lovely. Crowned
With lilies and with laurel they go; but I am not resigned.
Lovers and thinkers, into the earth with you.
Be one with the dull, the indiscriminate dust.
A fragment of what you felt, of what you knew,
A formula, a phrase remains,—but the best is lost.

a very big year for Slavica.
In June of 2004 she also
became a citizen of the
United States, but only to
find out a few days after
being sworn in that she had

The answers quick and keen, the honest look, the laughter, the love, —
They are gone. They are gone to feed the roses. Elegant and curled
Is the blossom. Fragrant is the blossom. I know. But I do not approve.
More precious was the light in your eyes than all the roses in the world.

been diagnosed with Stage
IV lung cancer. The tumor
had penetrated through her

Down, down, down into the darkness of the grave,
Gently they go, the beautiful, the tender, the kind;
Quietly they go, the intelligent, the witty, the brave.
I know. But I do not approve. And I am not resigned.

rib cage and was impinging
on her spinal cord. This was
a shock to Slavica because
—Edna St. Vincent Millay

Not to mention, she spent

Program Director. That was

many hours doing over the

she was a vegetarian, nonsmoker and would swim

phone interpretations,

several times per week for at

translating and subtitling movies from

As if these activities weren't enough, in

least 45 minutes per session. Additionally,

English to Serbian and, from time to time,

1999 Slavica completed a two-year course

Slavica loved to walk and was known to

would do voice-over radio commercial

of study and added to her skills a certifica-

walk from 82nd Street and Broadway to

work. Slavica took great pride in the pro-

tion as an English as a Second Language

the 34th Street Path Station. Despite this

fessionalism she sought to provide. If she

instructor and taught English to non-

devastating news she kept up with her

ever had a question about the meaning of a

English-speaking students, regardless of

work as a freelancer, program director and

particular word or phrase, she would

their native language. So, imagine, Slavica

mother. She always made sure to obtain

research via the internet, peruse the hun-

with Serbian as her primary language and

relevant speakers for monthly meetings and

dreds of books in her personal library, or

then teaching Chinese garment workers

to make arrangements for after-meeting

call people whom she thought could pro-

displaced by the events of 9/11/01 how to

gathering places. In October, Slavica began

vide her with the answer.

speak English. She did it and her students

chemo therapy and radiation treatments to

loved her.

her lung. Both treatments sapped her

es were provided to many organizations.

It is no secret that Slavica found out early

strength and caused her to lose her voice

To name a few: American International

that to develop her freelance activity she

temporarily. Her throat was burned from

Health Alliance (AIHA), United States

needed to have some networking capabili-

the radiation making swallowing anything

Agency for International Development

ty. So, she became an active member in

(USAID), Language Line Services, Peace

both the American Translators Association

X Peace, International Center in New York,

and the New York Circle of Translators as

Consortium for Workers Education,

well as the New York State Teachers of

Department of the Army, Open Society

English to Speakers of Other Languages

Institute, Society of Translators and

(NYS TESOL)

These translation and interpretation servic-

Interpreters of British Columbia.

It is also no secret that Slavica met many

a painful event. By December 2004, it
appeared that the size of the tumor was
decreasing. However, Slavica started to get
buzzing noises in her right ear and the right
side of her face was not moving. An MRI
showed that the cancer cells had spread to
the brain and facial nerves.
(continued on page 12)
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A WORD FROM THE EDITOR
by Rosene Zaros

Increasingly I am
afraid that we, as
Americans, are losing the ability to
read and to listen
critically. For many, the mere fact that
something is in print gives it credibility.
The words "experts say" seem to legitimize whatever is being said. There is
no need for examination or critical
analysis. I am both shocked and
depressed by forwarded emails that purport to be patriotic while, in reality, they
support causes that run counter to the
basic tenets of democracy in America.
This can only be happening because we
have become sloppy in our approach to
language and communication. We live
in a world of instant messaging and
buzz words, many of which are ambiguous at best. At worst, they incite
emotional responses that lead to shameful actions. Our so-called patriotism is
pushing us to behave in ways that are
downright "anti-American." We are told:
"America for Americans" and "Love it
or leave it." Does the latter mean that I
am not free to criticize some of the
things that I see happening in America?
— Perhaps only at the risk of being considered a security risk by the powers
that be.
When I remember how, after 9/11
America took solace in John Lennon's
beautiful song "Imagine," I wonder
if we were really listening to the
words — all of them. Or, were we only
listening to the last line of each stanza
where we are asked to "imagine all the
people living for today…living life in
peace…sharing all the world…and the
world will be as one." Those were the
things that we wanted with all our
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hearts, so it was easy to overlook the
other things that the lyrics ask us to
imagine?

been used by those in power and by

Let's go back now and look at the first
lines of each stanza where we're asked
to "Imagine there's no heaven…" and
"No hell below us…" It is getting
uncomfortable now because heaven and
hell are major religious concepts. In the
second stanza we are asked to "Imagine
there's no countries… and no religion
too." We have just been asked to imagine that the great American values of
God, church, and country do not exist
and that the world would be a better
place without them. Yet, if we examine
the course of religious history over the
past two thousand years and the accompanying rise of nationalism, we may
well want to ask some questions: How
many murders have been committed in
the name of religion? How many lost
lives can be attributed to patriotism?

those who share our beliefs and those

Because "patriotism" and "religion" can
engender such strong feelings in human
beings, they are very powerful forces
that can be used to control and manipulate entire populations. For this reason,
it may be beneficial to imagine, just for
a moment, a world without religion and
without nationality where there would
be "nothing to kill or die for…and the
world will be as one."

course that make us feel good, if we

Nevertheless both religion and nationality are deeply ingrained in the way
human beings define themselves. Right
now, we can only imagine a world
where human beings are able to transcend the negative influences of these
forces, but having once imagined it, we
will have gained greater insight into the
ways that religion and patriotism have

those who want to be in power to create
a wide and threatening schism between
who have different beliefs.
I was surprised this past weekend to
read that the ACLU, the ultimate bastion
of freedom of speech in America, is
attempting to prevent its board members
from openly criticizing the organization.
I see a parallel to this in the response of
the ATA to the articles by Marguerite
Shore and Alison Dundy that we printed
in the October 2005 issue. If we do not
feel free to question and to criticize our
own organizations, ourselves, in
essence, then we are truly witnessing the
decline of democracy in America.
If we continue blithely to accept the
words of "experts", if we continue to
remember only those sections of a discontinue to turn our eyes away from the
writing on the wall, the lessons of history, then perhaps we deserve our fate.
On the other hand, if we can imagine a
different world, we can also work
toward the realization of it. It is much
easier to imagine ways in which human
beings can work together within and
among existing belief systems than it is
to imagine destroying them and starting
anew. The word "tolerance" has a somewhat condescending connotation that
bothers me. I would prefer to use the
word "respect." We must all respect the
rights of one another to the extent that
those rights do not negate those of
another.
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THE ATA AND THE MOHAMMED YOUSRY CASE
by Bernie Bierman
The following article is based upon a letter that I wrote to NYCT member Marguerite Shore in late March of this year in connection with the
reaction of the American Translators Association to the Mohammed Yousry case. Since most readers of the Gotham Translator are already
quite familiar with the facts of Mr. Yousry's case, and in the interest of saving space, I shall omit repeating those facts.

first saw the name Mohammed
Yousry mentioned in connection
with an official statement that was
published in the ATA Chronicle in
March 2005. I read that statement cursorily, in the same way that I read most of
the contents of the Chronicle these days.

I

Six months later, the ATA Chronicle published a letter-to-the-editor from a group
composed of four ATA members. This
letter took polite exception to the ATA's
official statement regarding Mr.Yousry's
conduct as an interpreter for Lynne
Stewart, legal counsel to Sheikh Abdul
Rahman. That letter-to-the-editor, too,
initially received a cursory reading by
me.
However, when I saw that this letter-tothe-editor was the subject of an instant
rebuttal by then-ATA President Scott
Brennan and Alexander Rainoff of
NAJIT, if my interest per se was not
aroused, then certainly my sense of déjà
vu was.
This was, indeed, for me a case of plus
ça change, plus ça reste la même chose:
The ATA always needs to have the final
word lest, heaven forbid, the membership should be convinced of the merits of
a dissenting opinion! Indeed, the instant
response or instant rebuttal has been a
tactic employed by the ATA for close to
40 years against those who question or
criticize official ATA policy or conventional ATA wisdom.
Nevertheless, ATA's original statement,
the response contained in the letter-tothe-editor and ATA's instant rebuttal of
that letter still did not catch my full
attention. That attention came only when
I read another statement on the Yousry
case by NAJIT Director Judith Kenigson
Kristy in the February 2006 edition of
the Chronicle, a statement that received

the ATA official seal of approval and
attendant imprimatur.
Since the ATA's instant rebuttal published in the December 2005 edition of
the ATA Chronicle appeared to close the
door to any further discussion of the
Yousry case, I was quite mystified as to
why the Association was unilaterally
raising the issue again, but this time with
much more forceful language.

trary, the ATA permitted only a cherrypicked version of the Shore and Dundy
articles to reach its readers' eyes.
As I wrote to Ms. Shore, "While I
absolutely love cherries, I much prefer to
pick my own. I don't need ATA or NAJIT
or Ms. Kenigson Kristy to pick 'em for
me".

What I was witnessing here was vintage
ATA behavior, and that behavior constiWhat I did not know was that the
tutes an issue that I believe is of equal
Gotham Translator had published two
importance to the Yousry issue, and may
articles on the Yousry case in its October
be of even greater significance. In other
2005 edition, written
words, what we have
by Marguerite Shore
here is the NYCT airing
and Alison Dundy,
an issue in the style of
respectively, articles
PBS or NPR; we then
...what we have here is
that were critical of
have the ATA airing the
the NYCT airing an issue
the ATA's position
same issue in the style
in the style of PBS or
not just with respect
of FOX News Channel.
NPR; we then have the
to Mr. Yousry, but
Mohammed Yousry was
ATA airing the same
also with the
indicted, prosecuted,
issue in the style of FOX
Association's stance
tried and found guilty in
News Channel.
vis-à-vis interpreters
connection with acts
assigned to terrorthat aided terrorist
related criminal
activities, acts which
cases. Moreover, in
also included, or derived from, his conthe spirit of open and balanced discusduct as an interpreter, the allegation
sion, the Gotham Translator also
being that the crimes for which he was
published in its December 2005 edition,
found guilty derived from those acts that
a response to those two letters by Ms.
were beyond the bounds of his role as an
Kenigson Kristy, the very same response
interpreter.
that was published two months later in
the ATA Chronicle.
While the ATA-NAJIT statement of
March 2005 is relatively benign, and to a
However, Ms. Kenigson Kristy's piece
certain extent vague and non-committal,
published in the February 2006 edition
Ms. Kenigson Kristy's statement certainof the ATA Chronicle was not accompaly is not, and we must not lose sight of
nied by either Ms. Shore's article or Ms.
the fact that her statement has the full,
Dundy's article. What this signifies was
unequivocal endorsement of both organithat, while the readers of the Gotham
zations; therefore what is reflected
Translator were able to read all three (3)
therein is not merely Ms. Kenigson
articles in full, the members of the
Kristy's position, but the position of the
American Translators Association were
ATA and NAJIT.
not allowed that opportunity. On the con(continued on next page)
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The ATA-NAJIT statement of March
2005 says "Our organizations take no
position about the guilt or innocence of
individuals involved in any criminal
case."
Some 9 months later, Ms. Kenigson
Kristy, speaking for ATA and NAJIT
says "In the light of anticipated appeals,
our associations have preferred not to
publish statements containing concrete
examples of some of the ETHICS issues
in question".
Following that statement, Ms. Kenigson
Kristy proceeds to give various and
sundry detailed examples of what, in her
estimation and consequently in the estimation of ATA and NAJIT, are violations
of interpreter ethics Regrettably, space
limitations preclude me from giving Ms.
Kenigson Kristy's detailed examples of
Mr. Yousry's purported violations of
interpreter ethics, all the time reiterating
that she, the ATA and NAJIT "have preferred not to publish statements
containing concrete examples of some of
the ETHICS issues in question".
Clearly, the inconsistencies and the bias
of Ms. Kenigson Kristy, the ATA and
NAJIT are more than obvious. They are
glaring. In fact, about three-quarters of
the way through her letter, Ms. Kenigson
Kristy (and therefore the ATA and
NAJIT ) demote(s) Mr. Yousry from
interpreter to "interpreter", all the while
implying that she, the ATA and NAJIT
are neutral on the question of Mr.
Yousry's guilt, and don't wish to make
statements about his ethical transgressions!
Finally, having gone for the jugular, Ms.
Kenigson Kristy removes the pronoun
"I" from her vocabulary (possibly used
by her to give the reader the impression
that she has been expressing personal
opinion) and replaces it with the pronoun
"we" to make it very clear that the opinions advanced in this letter are indeed
those of NAJIT and ATA, to wit:
"In OUR [emphasis added] view, a judi-
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ciary interpreter is not doing his [sic]
job when he [sic] does the following:
(what follows are 7 citations of alleged
violations of interpreter ethics and proper behavior, all pertaining to Mohammed
Yousry)".

spokeswoman, Ms. Kenigson Kristy)
have not bothered to think through the
total picture of ethics, particularly in terrorist-related cases, and here I am not
referring so much to the Yousry case as
to cases that could very well arise (if
they haven't already arisen) in the future,
with which ATA and NAJIT are evidently ill-prepared to cope (or perhaps don't
want to cope).

There is something very puzzling, if not
phony about the approach taken by Ms.
Kenigson Kristy and the two organizations for which she
Almost ten years ago, the
speaks: If Mr.
late Tom Snow, one of the
Yousry's guilt was
One must ask whether
founders of the New York
even partially
organizations
such
as
Circle of Translators,
predicated on his
raised the question of
acts as an interATA and NAJIT have
interpreter ethics in conpreter, acts for
really thought through
nection with prisoner
which he was
all
the
myriad
issues
of
interrogation and the use
found CRIMIof extreme physical coerNALLY guilty,
interpreter ethics and
cion or, if you prefer,
how does one say
conduct in the very
torture. At the time, Mr.
"Well, I am not
real
and
brutal
world
Snow's concerns about
saying he was
such prisoner interrogacriminally guilty
of political terrorism.
tion and interpreter ethics
for his acts, I am
were viewed by many as
just saying that he
being somewhat "remote"
was ethically
or
even
"exotic".
But that was before
guilty for those acts".
September 11, 2001. It was before
Suppose Mr. Yousry was found guilty of
Guantánamo and Abu Gharaib.
robbing a bank at gunpoint, but on the
One must ask whether organizations
way out of the bank he had dropped
such as ATA and NAJIT have really
$100 in the hands of a crippled homeless
thought through all the myriad issues of
woman and another $200 in a Salvation
interpreter ethics and conduct in the very
Army kettle, would Ms. Kenigson Kristy
real and brutal world of political terrorand the good people of ATA and NAJIT
ism. Indeed, suppose Mr. Yousry had
say, "We can't comment on Mr. Yousry
been an interpreter in an interrogation of
criminal guilt, but we commend his high
a terrorism suspect by civilian authoriethical behavior of sharing his gains
ties, an interrogation in which extreme
with the poor and underprivileged".
physical coercion was employed, and
If Mohammed Yousry did, in fact, act in
suppose Mr. Yousry, repelled by what he
the manner of which he was accused by
was witnessing, walked off the job,
the government and found guilty by a
reported his experiences not to the
jury, then talk of ethics is meaningless
authorities (because of obvious reasons)
and, most certainly in that case, the issue
but to the news media, and was arrested
of ethics cannot be plucked from the
on various criminal charges.
issue of the crime and discussed as if the
Would in such case NAJIT and ATA concrime were non-existent.
demn Mr. Yousry for ethical violations,
I believe that in their narrow focus on
e.g., failing to serve the judiciary
ethical issues in the Yousry case, ATA
process, failing to take a neutral position,
and NAJIT (and, of course, their current
failing to inform authorities of a conflict
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of interest, namely his disgust at watching the results of electrodes placed on
the suspect's testicles. I must wonder
whether ATA and NAJIT and all those
who quote "canons of ethics and conduct" have given any thought to this
potential situation, a stark reality in the
world of and struggle against political
terrorism.
Political terrorism has changed the rules
in this game that we call ethics, and the
specifics of the Yousry case aside, it
seems to me that both ATA and NAJIT
are very ill-prepared to play the game.
And there are very good reasons for my
saying so:
The American Translators Association is
incapable - and has proven itself to be
incapable - of dealing with subjects that
it finds "controversial". The National
Association of Judiciary Interpreters &
Translators has at least tackled some
political issues that fall into the realm of
"controversial".
I find it sad, but certainly not unexpected, that this case, which has such
significance to us both as citizens and as
professional linguists, has been treated
so shabbily by the ATA insofar as it has
not promoted an open and frank discussion.
Most regrettably, but not surprisingly, the
discussion has been treated in that timehonored patronizing style of the ATA,
i.e., "We know what we are talking about
and know what is best for you. While we
respect your right to have a different
opinion [a statement that always conjures
up the yesteryear phrase of 'We are not
prejudiced against Negroes; some of our
best friends are Negroes'], we really
know what is right for you".
This reaction to and internal handling of
the Yousry case has been without question the result of an
historically-ingrained reluctance to confront tough and/or controversial issues,
and also an historically-ingrained intolerance of dissenting opinions, particularly

opinions that dissent from established
held itself out to the government as the
policy. Clearly, the use of the instant
ultimate expert on oral and written transrebuttal technique, the publication of
lation, key elements in the "war on
pieces that are favorable to its policies
terror". Even if ATA claims that this
and policy views with only carefully
effort has been made solely out of PR
selected references to the opposing viewconsiderations and to further the image
point, and the outright censorship of
and standing of translators and interviewpoints that are
preters, it has
pointedly critical of
nonetheless placed it in
official policy, are all
the political arena.
It is certainly no secret
manifestations of
that the ATA has held
In line with this,
ATA's lack of confiMarguerite Shore has
itself out to the
dence in itself and
suggested privately that
government as the
more importantly, in
ATA has become
ultimate expert on
its members. Worse,
extremely cozy with the
this reluctance to
oral and written
US government and
address tough and/or
specifically with the
translation, key
controversial issues,
FBI, a coziness which
elements in the "war
this need to stifle
she implies has led it to
on terror".
opinion that is criticondemn Yousry of
cal or even
being 'unprofessional'
hyper-critical of offiand to deny support to a
cial policy or official doctrine has left it
colleague who was doing his job and
incapable of dealing realistically with
now stands to go to jail for many years.
adversity.
If I hadn't had a chance conversation
What we have come to call by this
with a high ATA official who said preabstract term "war on terrorism" has
cisely what Ms. Shore suggested, I
come to ATA's (and NAJIT's) front door,
would have thought that her suggestion
brought there by the fact that so many
was a bit exotic. Clearly, there may be
political terrorists speak, read and write
more than just a modicum of truth to the
foreign languages.
charge that ATA's reaction (or lack of
As you may have noticed, I have used
reaction, depending on one's viewpoint)
the expression "political terrorism" and
has been motivated by political considernot just plain "terrorism". That was done
ations.
deliberately for the following reasons:
I do not believe that we have heard the
Throughout its history, or more accuratelast of the Yousry case, but what is more,
ly for the past 36 years of its history,
I believe that we are going to see more
ATA has followed a course of staying as
and more cases involving interpreters
far away as possible from political issues
that will be "controversial", and worse,
(and obviously I exclude internal poli"politically controversial". And, unless
tics). Clearly, external politics has been
ATA engages in an open and frank diadesignated anathema.
logue between its officials and members
about the numerous problems conBut through none of its direct doing, but
fronting our colleagues who are in the
rather through "la forza del destino", extertrenches of terrorism-related cases, and
nal politics have penetrated ATA. Today's
about how we can help our colleagues
terrorism is politically-driven; it is a politiwho are wrongly accused or prejudiced,
cal reality and the language factor is very
the organization's credibility will be open
much a part of that political reality.
to even greater question. Its very own
It is certainly no secret that the ATA has
history has clearly demonstrated that.
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TRANSLATING ARABIC INTO INJUSTICE
by Zachary Lockman
Zachary Lockman chairs the department of Middle Eastern and Islamic studies at New York University.

I

have been teaching modern Middle
Eastern history for more than 20
years. I've helped train many graduate students, some of whom have gone
on to become professors at universities
across the country. But one of my current
New York University graduate students,
Mohammed Yousry, faces a very different future. Convicted a year ago of
participating in a conspiracy to abet terrorism, he may be sentenced to as many
as 20 years in federal prison.
Knowing Mohammed as I do, and having followed his trial closely, I am
convinced that he is a victim of the kind
of excessive prosecutorial zeal we have
seen all too much of since 9/11. But his
case is especially disturbing because
what may put Mohammed behind bars is
the work he did in good faith as a translator and an academic researcher. This
would turn a travesty of justice into a
very dangerous precedent.
A gentle and unassuming man,
Mohammed came to this country from
Egypt 25 years ago. He and his wife (an
evangelical Christian) had a daughter
who would eventually graduate from a
Baptist college. Mohammed became a
U.S. citizen. When I first met him in
1995, he was a graduate student at NYU,
paying his tuition and supporting his
family by driving a taxi and by working
as a translator of Arabic for journalists
and lawyers. One of the lawyers who
hired Mohammed was Lynne Stewart,
among whose clients was Sheik Omar
Abdel Rahman, the blind former spiritual
guide of a radical Islamist organization
in Egypt who is now serving a life sentence for plotting to blow up New York
City landmarks.
When Mohammed began to discuss pos-
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sible doctoral dissertation topics with me
seven or eight years ago, I encouraged
him to write a political biography of
Abdel Rahman, partly because his
employment as a translator for Stewart
gave him unique access to the imprisoned cleric. Though a lifelong secularist
and democrat who totally rejects Abdel
Rahman's extremist version of Islam,
Mohammed started gathering material on
the cleric for his dissertation, and even
interviewed him about his ideas and
political career during governmentauthorized prison visits with Stewart.
Mohammed's diligence as a translator
and an academic researcher would cost
him dearly. In April 2002, he was arrested, along with Stewart and one of her
paralegals. They were accused of conspiring to provide material support to
terrorists. Two years earlier, Stewart had
told a reporter that the imprisoned Abdel
Rahman opposed a cease-fire that his
supporters had negotiated with the
Egyptian government. Though no act of
violence ever resulted, the U.S. government claimed that Stewart had not only
violated government regulations —
which she had agreed to follow —
restricting communications with Rahman
but that she had also abetted terrorism.
Whatever Stewart may have done, however, it is hard to see how Mohammed
can be held responsible for her actions.
As a government-approved translator, he
was never even asked to agree to the regulations Stewart was accused of
violating, and he had no reason to question the lawfulness of his employer's
instructions. During the trial, prosecutors
made contradictory arguments. They
insinuated that Mohammed had knowingly broken the law in order to further

his scholarly research, and even that he
was an acolyte of Abdel Rahman. But
they also acknowledged that Mohammed
had never advocated violence or Islamic
fundamentalism. My guess is that the
real reason they went after Mohammed
was to get Stewart: She knew no Arabic,
and Abdel Rahman knew very little
English, so without including
Mohammed in the alleged conspiracy,
prosecutors wouldn't have had much of a
case.
Mohammed, shellshocked by what has
happened to him, faces sentencing in
March, though appeals will surely follow. Many lawyers have rallied to
Stewart's defense because they believe
that the government targeted her in order
to deter other lawyers from zealously
defending clients accused of terrorism,
and because they feel that her case raises
serious constitutional issues.
Mohammed's prosecution raises somewhat different, though equally
disturbing, questions. Should a translator
be sent to prison for following his
employer's instructions, especially when
the prosecution failed to prove that he
intended to break any law? Can a graduate student's dissertation research
reasonably be construed as contributing
to a conspiracy to help terrorists?
If Mohammed's conviction is allowed to
stand, we may well see other translators
prosecuted for doing their jobs, and other
scholars facing jail terms for conducting
research on controversial issues. That
would undermine core values we profess
to cherish, including academic freedom
and other civil liberties. It would also
weaken our ability to understand Muslim
extremism and successfully confront it.
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LOST IN TRANSLATION
by David Cole

ranslation is the art of erasing
in the most prejudicial way possible.
oneself in order to speak in
They played irrelevant tapes of Osama
another's voice. Good translators
bin Laden for the Manhattan jury. And
speak for others, not for themselves. So
they refused to sever the trial of Stewart
when NYU graduate student Mohammed
and Yousry from that of Ahmed Sattar,
Yousry took on the job of translating
who had engaged—without Stewart's or
Arabic for lawyers representing Sheik
Yousry's knowledge or approval—in
Omar Abdel Rahman, the blind Egyptian
egregious and plainly criminal conduct,
cleric convicted of conspiring to bomb
issuing a fake fatwa from the sheik urgseveral bridges and tunnels around
ing followers to "kill Jews everywhere."
Manhattan, Yousry
Yousry was essentially
agreed, like any good
held liable for his part
translator, to follow
Yousry and the sheik
in Stewart's "crime" of
his lawyers' lead. For
issuing a press release
were often the only
doing his job, he now
purporting to represent
ones in the room who
faces the possibility
the sheik's views on a
spoke Arabic. Had they
of twenty years in
cease-fire in Egypt.
truly been co-conspiraprison as a supporter
But Yousry did not
tors, they could have
of terrorism. He is
even sign the adminisplotted all sorts of illicit
scheduled to be sentrative agreement that
activities without the
tenced in a federal
Stewart contravened.
lawyers or the guards
court in New York in
He was a translator,
September.
knowing.
not a lawyer, and he
His case has received
relied on the lawyers
far less attention than
to make the decisions
that of his more prominent co-defendant,
about what could be communicated to
civil rights attorney Lynne Stewart, but if
the sheik, and about what could be said
anything his conviction is even less
about the sheik to the outside world. It
defensible. I criticized Stewart's convicwas Stewart's decision, not Yousry's, to
tion last year [see Cole, "The Lynne
issue the press release in question, and
Stewart Trial," March 7, 2005]. Stewart
he played no role in that decision. In
undoubtedly contravened an administrafact, Yousry, a non-practicing Muslim
tive agreement when she issued a press
married to a Baptist who raised their
statement on behalf of the sheik at a time
daughter as a Christian, was never a folwhen she had sworn not to facilitate his
lower of the sheik and had publicly
communications with the general public.
accused the sheik of seeking to replace
But failing to adhere to an administrative
one form of totalitarianism in Egypt with
agreement is not a crime, so prosecutors
another.
trumped up the charges by claiming that
The government's theory was that by
she had criminally defrauded the governtranslating the sheik's words, which
ment and provided material support to
Stewart eventually issued in the press
terrorism. They then tried her and Yousry
release, Yousry was a co-conspirator in
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the crime. But the notion that Yousry
was a conspirator is belied by the record.
Unbeknownst to Yousry, the government
taped the prison meetings with the sheik,
as well as Yousry's phone conversations.
In the prison meetings, Yousry and the
sheik were often the only ones in the
room who spoke Arabic. Had they truly
been co-conspirators, they could have
plotted all sorts of illicit activities without the lawyers or the guards knowing.
Yet the tapes show that Yousry never
talked to the sheik about anything that
was not approved in advance by the
lawyers, and never communicated the
sheik's words to anyone other than the
legal team. Yousry consistently sought
advance approval from the lawyers as to
what he could discuss with the sheik and
adhered to their instructions at every
stage.
Following the lawyers' lead would not be
a defense in every situation, of course.
Had Stewart told Yousry to shoot one of
the guards to assist in a jail break, it
would be no defense that he followed her
instructions. But translating the sheik's
words was exactly what Yousry was
hired—with government approval—to
do. The lawyers then decided what to do
with that information. It was not Yousry's
decision. But it is Yousry's freedom that
will be taken away.
Reprinted with permission from the
May 15, 2006 issue of The Nation magazine. For subscription information,
call 1-800-333-8536. Portions of each
week's Nation can be accessed at
http://www.thenation.com.
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TRANSLATION TOOLS SEMINAR
AN ATA PROFESSIONAL DEVELOPMENT EVENT
JERSEY CITY, NEW JERSEY, MAY 13, 2006
Reviewed by Rosene Zaros

lthough this was the second time
in less than a year that I attended
one of Jost Zetzsche's seminars,
I found it every bit as interesting
and informative as the first time around.
In fact, it made me think that it would be
a good idea to attend a seminar like this
every year. There is so much to learn and
Jost makes it a fun-filled process.

A

He began by giving us some interesting
statistics on the degree to which translators utilize the tools that are available to
them. Out of a total of 300,000 translators and interpreters worldwide, only
30-35,000 of them use the internet regularly and only about 10-15,000 use
translation memory technology.
Becoming a proficient computer user
may be one way to distinguish ourselves
and compete.
Concentrating on the Windows platform
and applications, Jost gave specific
instructions and tips for fine-tuning operating systems and applications to suit the
needs of individual translators. Why
Windows? Although it may not be the
best operating system, there is always
the issue of compatibility. He talked
about the advantages of Windows
2000/XP vs. earlier versions. These
include greater stability, additional applications, and multilingual editions
offering the possibility of booting in
other languages, and Unicode, which is a
way of processing all known languages.
He gave many tips for using Windows
Explorer effectively and for maximizing
the power of Windows. One tip that is
very easy to pass on: Do not turn off
your computer! Although you may feel
that you are wasting electricity, it is infinitely better for your computer to leave it
on. You may also want to take a look at
the programs that are on your Startup
menu. There may be some that you do
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not need or want and they may be slowing down your computer.
In his discussion of HTML Editors, Jost
had two big caveats: Never use Word for
HTML unless the client specifically asks
you to do so and only use "intrusive"
HTML editors if the website was created
with them. He spoke of spiders such as
Teleport that allow for the download of
complete websites. Although they are not
suited for translation, they are good for
estimates.
Jost was very enthusiastic about a number of free or very inexpensive utilities
that can be downloaded and some advice
on which ones to avoid at any price.
There are utilities to search and replace,
to search with regular expressions,
indexing tools, tools for renaming batches of files, for "touching up" date- and
timestamps, clipboard utilities and compression utilities such as PKZip and
WinZip. While Word can perform almost
any of these functions, it is another question whether it is the best tool for the
job. It brought to mind an old adage: "A
poor workman blames his tools; a good
workman would not use poor tools."
Unlike the previous seminar I attended,
this time Jost spent more time on CAT
Tools, which he defined as "all tools that
aid in the translation process. He touched
on the following categories:
• project management applications such
as LTC Organiser, Translation Office
3000, and ]project-open[
• Term extraction tools such as Zerox
XTS, LogiTerm, TermExtract,
SDLPhraseFinder.
• Word count tools such as PractiCount
and AnyCount.
• Localization tools
• Machine translation programs

• Translation environment programs,
which he feels is a better term for
translation memory tools.
Yost expanded on the latter category by
classifying these programs into two subcategories:
• Tools that perform all or most work
through macros in Microsoft Word and,
thus, may not be great for pdf files.
• Tools that let the translator work in an
independent environment.
He spoke of the similarities that exist
among all the major tools (Trados,
SDLX, Transit Déjà Vu) :
• Configurable terminology component
• Unicode and TMX support
• Alignment feature
• Similar range of supported file formats
• Concordance searches
• Analysis features
During the seminar, we were given a
handout with many useful links, tips and
tricks. We also received a copy of the
latest edition of his 200-page e-book
Translator's Tool Box : A Computer
Primer for Translators. The book is
available on line at www.internationalwriters.com/toolbox/. You may also
subscribe to a free Tool Kit newsletter at
www.internationalwriters.com/toolkit.
About the Speaker: Jost Zetzsche is an
ATA-certified English>German translator
and a localization and translation consultant. A native of Hamburg, Germany, he
earned a PhD in the field of Chinese translation history and linguistics and began
working in localization and technical translation in 1997. In 1999, he co-founded
International Writers' Group on the Oregon
coast. His computer guide for translators
was published in 2003 and he now sends
out a biweekly technical newsletter for
translators.
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TRADOS OVERVIEW
by Lana Rachkovskaya, Program Director

I

n an effort to make our readers aware of the various workshops and seminars, we are printing an overview of the workshop presented by Wim Schrieks, technical lead for Bowne Translation Services.

The presenter made the audience aware of the role that will be played by CAT and TM tools as we make our way through
the 21st century and of ways that we can use these tools to enhance our translations and, ultimately, our incomes. We are all at
different stages in our ability to work with these tools and, thus, we have limited our coverage of the workshop to a brief
overview of the functions of Trados.

TRADOS OVERVIEW

2. Click button Open/Get

On tab Files:

CREATING MEMORY

3. Types translation in box that opens

1. Open Workbench

4. Click button Set/Close Next
Open/Get

4. Add the source file under the source
language and target file under the target language

2. Go to New
3. Set Source language and Target and
click Create
4. Give the file a name that makes sense
for you and remember where you
save it. It is recommended to include
customer or project name and language combination.
Please note that 5 different files were
created all with same name. These files
need to stay in the same folder. It is recommended not to change the file names.
If any of these files is deleted or its name
has changed the translation memory will
not work anymore and in most cases it
will be irreparable.
The memory is empty. There are different ways to get translations into the
Memory.
Below I describe the 3 most common
ways.
ADDING TRANSLATIONS TO
TM WHILE TRANSLATING A
DOCUMENT

• Open Workbench
• Open MS Word
Prepare your screen in a way that you
can see both windows at the same time.
If TRADOS is properly installed there is
a TRADOS toolbar and a TRADOS
menu available in MS Word. (see handouts of meeting)
1. Place your cursor at the first
sentence.

5. Your translation is saved in the
Memory and the next box opens for
translation
6. You continue with the translation
until the document is translated
7. If a segment was translated before
TRADOS will place that segment
8. If a similar segment was translated
TRADOS will show you a fuzzy
match; in Workbench you can see
what the difference is.
9. TRADOS will save the source text
as hidden text. Check Tools >
Options > Formatting Marks >
Hidden Text to make this text
visible.
ALIGNING EXISTING
TRANSLATION

If you have both source and target of a
certain text you can add the translations
with WinAlign. WinAlign will allow you
to connect a sentence from the source
document with its translation in the target document. Before you start you need
to make sure the source and target contain the same content, are saved in the
same file format and have similar formatting.

5. Click Align file name
The window Project:
6. Doubleclick on file name
A window will now popup that shows
you left the source document and right
the target. WinAlign suggest with dotted
lines which segments belong together.
7. Scroll through the list and review
every pair. With the right mouse click
options you can delete connections
and make new connections. If you
place the cursor in the text you can
edit the text, with the right mouse
click options there you can also split
segments and add segments.
8. When done. Go to File > Export
File Pair
9. Open then Workbench
10. Open the correct Translation Memory
(see above) or create a new one.
11. Go to File > Import
12. Import the file you just exported in
WinAlign (it is a text file)
USING AN EXISTING
TRANSLATION MEMORY

Winalign works as follows:

This will happen when your customer
requires you to work in TRADOS. There
are 2 scenarios:

1. Open WinAlign

Customer sends a Translation Memory:

On tab General:

1. It should contain all 5 necessary files

2. Set source and target language

2. Copy them in the same folder and
doubleclick on the *.tmw file. The

3. Choose File Type

(continued on next page)
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memory opens in Workbench. You
can now start translating.
NB: This method will not work if you
are using an older version of TRADOS
then your customer.
Customer sends an export file from the
Translation Memory
The procedure is the same as for importing the results of an alignment (see
above). This procedure has the advantage
that it is version independent. If you
have an older version then your customer
you still can work with this file. (except
between version 7.* and older versions if
you are working with non Western languages)

(continued from page 3)
In March 2005 Slavica started radiation treatments to the brain and commenced a
new regimen of chemo therapy at Sloan-Kettering. The trips to receive these treatments were in and of themselves exhausting.
The ringing noises in her right ear never went away and Slavica had to stop interpreting. However, she started to get more work doing translations and was kept
especially busy doing sub-title work for movie translations. In fact, although Slavica
was hospitalized four times in 2005, she often did translations on her lap top while
being hooked up to IV's. Her Doctor at Sloan Kettering used to laugh and say
"Slavica, you are the only patient I know of that comes to the hospital and works".
Oddly enough, in 2005 the Circle also found itself in a precarious position. There
was no President-Elect and the President's term had expired leaving only three Board
members: the Secretary, the Treasurer and the Program Director. Slavica read over

OTHER BASIC FUNCTIONS

the By-laws along with Robert's Rules of Order and figured out that the three-mem-

Tools > Analyze

ber board could appoint a President and the President could then appoint a President

• Gives you a word count, number of
fuzzy matches and repetition.

elect. Slavica, threw her hat into the ring and by July, after finding a substitute

• Useful for planning and billing.

Program Director, had single handedly created a full Board of Directors with herself
as President. In addition to establishing a functional Board of Directors, there were

• Note that TRADOS does not count
segments that do not contain
translatable text. (For instance a cell in
a table with only numbers)

some financial issues that had to be remedied. Slavica, in her most direct, dignified

Tools > Translate

All in all, Slavica not only kept on top of her personal issues but the issues of the

• Allows you to pretranslate a file.

Circle as well. Unfortunately, towards the end of 2005 it was no longer possible for

• TRADOS will search in TM for
segments that were already translated
and add them to the document.

Slavica to do anything by herself. It was necessary for Slavica to have someone with

• You can choose to translate only 100%
matches or also fuzzy matches

but stern manner made sure that the treasury issues were quickly resolved and that a
new contract was entered into to upgrade the Circle's web-site .

her at all times and she needed to have an arm to hold when leaving the house.
Through all this, Slavica not only accomplished so much but she remained in high
spirits. Very often, she would apologize to others for their having to help her and yet

• Useful if already large parts can be
translated

she never complained or got down in the dumps. The end came on the afternoon of

Tools > Clean

ner by her side. With her in that room were the people she loved and cared for and

• Will remove the TRADOS 'hidden text'
and will give you a clean target file

who loved and cared for her as well. Oh, yes, and not far away were all her friendly

• Allows you to update the translation
memory with changes made

music compositions you can find. Slavica's perseverance, integrity, tenacity, profes-

• Updating the memory with Clean is
useful if you share a file with another
translator and that translator made
changes

composers. Why? Because she was one fine lady with a lot of class.

Tools > Concordance

York. The service will include singers, guitar players, pianists and readers of poems

• Allows you to search for terms in the
Translation Memory

Slavica herself selected. Apparently, she still has a message to share and all are wel-
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June 2nd Slavica was in bed at home with her mother, her son, and her loving part-

books, a collection of National Geographics, and 40 CD's of the greatest classical
sionalism and love of people put her right up there with those great writers and

Slavica's Memorial Service will be held on Saturday July 15th at 6 p.m. at the West
End Church on the corner of 86th Street and Amsterdam Avenue, New York, New

come to attend this fine tribute.
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NYCT MAY MEETING

going through your personal account

SPEAKER: MARK RATAFIA, BEACON PARTNERS, CPA
TOPIC: TAX PLANNING AND SAVINGS
THURSDAY, MAY 4, 2006

information where personal expenses are
mixed with business expenses. It is also

by Lana Rachkovskaya

your business expenses. When you travel

T

he speaker covered legal / tax

A noted speaker, he has conducted semi-

structures that are most opera-

nars on a variety of tax and accounting

tionally efficient for freelance

topics, and has authored numerous tech-

translators and businesses, basic income

nical articles. For more information on

tax concepts, employee/employer rela-

Beacon Partners CPA, please go to

tionships vs independent contractors, as

www.beaconcpa.com.

well as what to expense, when to
expense it, record-keeping, and tax filings. This was a great opportunity for all
of us to ask questions and to better
understand how to manage our taxes as
independent contractors in order to save.
Mark Ratafia started his professional
career in the corporate tax department of
KPMG Peat Marwick, a leading global
professional services firm. He later
joined American Express Tax &
Business Services in New York City,
where he was responsible for managing
tax functions for a diverse clientele,
including domestic and international corporations, partnerships, individuals,

Mark began by explaining what cannot
be deducted on our tax returns, such as
clothing, improvements to summer
home, and other expenses of the personal

variety of questions related to filing,
expenses and tax records, as well as
what can be expensed when you work
from home and when you own a home.

sion, that does not mean extending the

it is a gray area, in short, an employee

time to pay. If you start a pattern of late

could be described as someone who

filing, you will loose credibility with the

works in your office, takes direction on

IRS. In conclusion, the two most impor-

how to do his/her job and is supervised.

tant things to remember are: file on time

An independent contractor is someone

and be certain that your tax return

who works independently and has all the

reflects your business activity and only

tools and resources to perform a certain

your business activity.

task. What is relevant to our business is

Company, a firm of 250 professionals

checks, diary and Quick Books.

that provides accounting and tax solu-

According to Mark, most people use

tions to Bloomberg, LP as well as a host

Quick Books now. It is easy to use and

of private equity and venture-backed

to maintain.

Society of Certified Public Accountants.

Then the audience proceeded to ask a

the IRS sees those relationships. Although

There are several methods: credit cards,

Public Accountants and the New York

business-related in case you get audited.

in a timely manner. If you take an exten-

Director of Taxation at Geller &

both the American Institute of Certified

for you to prove that the expenses are

employer/employee relationships and how

one can maintain accounting records.

Graduate Division. He is a member of

and expenses, which will make it easier

extremely important that taxes are filed

Beacon Partners CPA, Mark was a

in Taxation from Fordham University

keep a diary of your business activities

Mark also commented on the issue of

Mark further proceeded to discuss how

Accounting and his Masters of Science

on business, Mark recommends that you

nature. He also pointed out that it is

trusts and estates. Prior to founding

companies. Mark earned his MBA in

useful to have a separate credit card for

that, when you hire a translator, editor or
an interpreter, it is your responsibility to
issue a 1099 to them. A Form 1099 is the
only way the government can check that
the freelancer has been paid. The deadline
for issuing the 1099 is January 31. Mark
also mentioned the 20 Factor Test—you
can google it. This is how the IRS deter-

Mark also recommended that freelance

mines if your professional relationship is

translators have a business account. This

employee/ employer or if you work with

way it is much easier to track all busi-

an independent contractor. Such factors as

ness expenses and income. It is also

training, Mark tells us, can change every-

easier for IRS to see where the money

thing. It is certainly worth knowing.

went and where it came from, rather than

(continued on next page)
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If you misclassify an
employee as an independent contractor,
and you do not pay
employment taxes,
you may be liable for
significant interest and
penalties. As this is an
area of significant revenue for the
government, compliance is strictly
enforced.
Furthermore, payroll
tax liabilities are the
personal responsibility of company officers, even in a corporation.
We also were able to talk about the various legal structures of a company and
the audience had a chance to participate.
Of course, the main concern for everyone is what would be better for me —
LLC, Incorporated, S-Corporation, etc.

shares and it has perpetual existence.
PARTNERSHIP

legal advantages of a corporation and the
flexibility of a partnership, this is often

agree to pool their funds and talents and

the optimal form of many privately-held

who will share in the profits and losses

businesses.

of the enterprise.

S/he will consider your personal situa-

responsible for the day-to-day manage-

tion and you will be able to get the right

ment of activities, whose individual acts

answer.

are binding on all the partners, and who

Liability Company (LLC), or a Sole
Proprietorship.
CORPORATION

A corporation is a legal entity chartered
by a state that is separate and distinct
from the persons who own it. A corporation may own property, incur debts, sue
or be sued. Some distinguishing features
of corporations are that stockholders
have limited liability (they can only lose
what they invest), transfer of ownership
is accomplished through the sale of stock
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a sole proprietorship. Since it has the

ing at least two owners ("partners") who

The answer is — talk to your accountant.

Corporation, a Partnership, a Limited

LLC has only one member, it is taxed as

A partnership is a business venture hav-

General partners are those who are

A business can be formed as a

there are two or more owners. If the

are personally responsible for the partnership's total liabilities. Limited
partners are those who contribute only
money and are not involved in management decisions and whose liability is
limited to the amount of their investment.
LIMITED LIABILITY COMPANY
(LLC)

A limited liability company or "LLC" is
a legal entity form that provides limited
liability for its owners ("members") similar to a corporation, but may be taxed as
either a partnership or corporation if

SOLE PROPRIETORSHIP

A sole proprietorship is the simplest and
most common form of small business. It
is an unincorporated business with a single owner who is personally liable for
business debts and claims against the
business. The operating results of the
business are reflected on the owner's personal tax returns and are considered
self-employment income.
The meeting was certainly most useful,
and I am sure many of us left with various items to put on our to-do lists. As
they say, knowledge is power, and it is in
our own interest to educate ourselves and
to protect ourselves when dealing with
tax filing and records.
Note: This article should not be considered as legal advice.
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CIRCLE NEWS
MIDSUMMER PICNIC
Sometime in July. More information will be
forthcoming.

MEMORIAL SERVICE

FOR

SLAVICA

STANDARD BILINGUAL LEGAL
DICTIONARY JAPANESE/ENGLISH
AVAILABLE ONLINE
The Japanese government's official English
translations of certain (about 230 pages
worth) Japanese legal terms is available

Saturday, July 15, 2006 at 6 PM at the West

online. The following url links to a (3MB) pdf

End Church on the corner of 86th Street and Amsterdam

on the Japanese Cabinet Secretariat's site that contains

Avenue, New York, New York.

the dictionary:

CHARLES M. STERN AWARD —
REMINDER
Nominations for the Stern Award will be due in a few
months. As mentioned in an earlier Gotham, the award

http://www.cas.go.jp/jp/seisaku/hourei/dictionary.pdf

More information can be found on this page of the
Cabinet Secretariat's web site:
http://www.cas.go.jp/jp/seisaku/hourei/data1.html

was created in the late 1990s as a bequest from Charles

…including this link to a site containing further links

M. Stern, a former member. It is awarded annually to

to English translations of some Japanese laws and

active, needy members of the Circle, one male and one

regulations:

female. So please start thinking about possible candidates.

http://www.cas.go.jp/jp/seisaku/hourei/data2.html

The nominations should be in writing, and contain a brief

— from Kyal Hill, Legal Translator,
Mori Hamada & Matsumoto

biography of the candidate, and some documentation of
how the award would be applied.

CALL FOR PAPERS
The Gotham Translator accepts and welcomes contributions of articles about all aspects of translation
and translator-related issues. These may include, but are not limited to, specific translation problems
or approaches to translation, legal issues, and the business of translation. We also welcome dictionary
and hardware/software reviews as well as reviews of books, conferences and workshops. The
"Members' Voice" section of each issue is devoted to translations, stories, and poetry written by
members.
In general, articles and other submissions should be limited to around 1500 words. All text should be
submitted as e-mail attachments in Microsoft Word format. We prefer unpublished contributions. In the
case of previously published submissions, please advise us of this fact at the time of submission.
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The New York Circle of Translators (NYCT) is a New York State not-for-profit
corporation grouping independent translators and interpreters as well as
companies and organizations. It is a chapter of the American Translators
Association (ATA) which is, in turn, an affiliate of the International Federation
of Translators (FIT).
NYCT members work in a variety of languages and specialties. Our members
are committed to the exchange of ideas and mutual support. One of our
goals is to educate the general public about the professional nature of
interpreting and translating.
NYCT members enjoy the following benefits:
• Free monthly meetings featuring speakers on all aspects of the translation
profession
• Networking opportunities at monthly dinners and annual holiday party
• Professional development workshops and seminars
• Subscription to our newsletter, The Gotham Translator
• Listings in the NYCT Online Membership Directory and the annual NYCT
printed Membership Directory
• Referrals (if you indicate that you accept them, existing members may
direct work requests to you or clients may contact you directly)
Visit us at www.nyctranslators.org and join online!

PO Box 4051
Grand Central Station
New York, NY 10163-4051

